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PRO Challenge Quick Reference Keyboard Guide

IBM
GENERAL KEYS

[C] Change coaches and coaching personas
[D] Delay speed adjust slow/NORMAL/fast

[E] Extra fast mode on/OFF

[F] Freeze game (press any key to continue)
[G] Graphics mode ON/off (RGB Color only)
[1] Instant replay ON/off (RGB Color only)

[L] Learn mode on/OFF
[N] New game
[P] Display Play names ON/off

[R] Display Results (statistical)
[S] Sound ONJoff

[U] Undo previous play

[V] VERBOSEherse message switch
[W] Windows ONJoff

[X] Exit program
[Alt] [S] Save game

[Alt] [R] Restore saved game

Coaches’ Keypads

Left Keypad Right Keypad
[F1] to [F10] Number keys  [1] to [9],[0]*
[Esc] (@) Cancel key H”
| 5] Enter key (]
[\] (Z) Coaching key [/]

*on numeric keyboard

( ) refers to keys on the PCIAT, where different
NOTE: The defaults are shown in capital letters.

Macintosh
The Menu Bar

Apple Menu
About Pro Challenge

File Menu Configuration Menu
New Coach

Open Delay Speed

Save Play Windows

Quit Sound

Keyboard

Game Menu
% F Freeze/Continue

3 S Statistics

Left Coach Box
Right Coach Box

3¢ U Undo

36 96 36 36 36 3¢
vT==—oOmr

Option Menu
Learn

Extra Fast
Graphics

Instant Replay
Verbose Message
Play Names

Coaches’ Keypads

Left Keyboard &
Config. A Keys
(1] to [9], [0]
---and ---
(1], [2], [3]
(@], [W], [E]
(A], [S], [D]
[>] -

[Tab]
[Z]

Right Keyboard &
Config. B Keys
Number keys [1] to [9], [0]*

Cancel key [Backspace| [Clear]*
Return key  [Return] [Enter]*
Coaching key [/] [/1*

*0n numeric keypad




PRO Challenge Glossary

Explanations of Terms Used in Play

Names And Descriptions

A. The halfback (e.g., Shotgun, A,
B Divide).

B. The fullback (e.g., Shotgun, A,
B Divide).

Buck. The inside linebacker
opposite the strongside of the
offensive line.

C. The slotback. The backfield
player who lines up in the slot
between the wide receiver and the
interior line (e.g., Shotgun, C Post).
Contain Defenders. The contain
men of the defense (see

Contain Man).

Contain Man. The defender re-
sponsible for not letting the ball
carrier get outside, forcing him back
to the other defenders in the
middle.

Dime Defense. A pass defense in
which a second linebacker is re-
placed by a sixth defensive back,
the dime back. (see Nickel
Defense).

Double Zone. A pass defense with
2 deep zones.

Draw Play. A running play
designed to look like a pass play.
Flat. The short (or underneath)
zone next to the sideline.

Mike. The middle linebacker in a
4-3 defense.

Nickel Defense. A pass defense in
which a linebacker is replaced by a

fifth defensive back, the nickel back.

Post Pattern. A pass route where
a receiver runs straight at the
goalpost.

Sam. The outside linebacker
opposite the strongside of the
offensive line.

Streak. A pass route where the
receiver streaks (runs) downfield as
fast as he can.

Strongside. The side of the
offensive line (and thus the field)
which has the tight end. In pass
formations it is the side with two
receivers.

Trap Play. A running play in which

a defensive lineman is not blocked,
inviting him to rush forward where
a pulling guard (or tackle) can blast
him.

Twist. A defensive maneuver where
two rushers line up normally, but
switch rush lanes.

Under - Underneath. Refers to the
pass defense ‘“‘underneath’” the
deep zones.

Under - Undershift. A defensive
formation in which linemen shift
one position toward the weakside.
Weakside. The side of the
offensive line which does not have
the tight end.

Will. The outside linebacker oppo-
site the weakside of the offensive
line.

Willy. A zone defense with three
deep zones.

X. The split end (e.g., X, Z Streak).
Y. The tight end (e.g., Shotgun Y
Cross).

Z. The flanker (eg., Slot X, Y, Z
In).
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Offense: Introduction

The offenses available in PRO Challenge A useful thing to do before a game is to  will face will have its strong points and its
reflect the variety of offensive strategies create a game plan, which begins with weak points as well.

found in the NFL today. There are four selecting those plays on the Playcard But a game plan means more than just
groups of plays which include short which you think will work best for your picking a set of plays; it also means
yardage plays (such as dives over the team. Your team might have a balanced deciding which of those plays you will call
line), long yardage plays (such as shotgun offense, or it might have an offense that is in all the various situations that may come
plays), special plays (such as punts and clearly better at either the pass or the run.  up in a game. You are likely to want to call
field goals), and plays for all situations In addition, it might have a stronger line a riskier play in long yardage situations, on
based on typical professional formations. on one side or the other. The defense you  third down (except third-and-very-short), or
OFFENSIVE PLAY GROUP 1 BLUE 1. Quarterback Sneak 2. Fullback Power

Situations: Short yardage
Formation: Two set backs, three tight ends

1. QB Sneak (Run) RG: Short |

2. FB Power (Run) RG: Short EEIER RN KSR R
3. HB Lead (Run) RG: Short ‘ \

4. All Strong (Pass) RG: Medium

5. Y, Z Cross (Pass) RG: Medium

3. Halfback Lead 4. An strong Pass | 9. Y, Z Cross Pass

OFFENSIVE PLAY GROUP 2 YELLOW . Fullback Dive Strong /. Halfback Counter Weak
Situations: All situations -

Formation: Various

1. FB Dive Strong (Run) RG: Short
2. HB Counter Weak (Run) RG: Medium
3. FB Streak Pass (Pass) RG: V. Long

FLCSE

4. FB Trap Strong (Run) RG: Sting ‘/
5. SS Quick Pass (Pass) RG: Long -
6. WS Rollout (Pass) RG: Long #. Fullback Streak Pass

7. All Streak (Pass) RG: V. Long
8. HB Toss Sweep (Run) RG: Medium
9. TE SS Screen (Pass) RG: Sting
10. Sweep Play Action (Pass) RG: Long

. Strongside Quick Pass . Weakside Rollout Pass /. Al Streak Pass
RS
', Halfback Toss Sweep “'. Tight End Strongside Screen 11/, Sweep Play Action Pass
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if you are behind late in the game.
Similarly, you are likely to want to call a
less risky play in short yardage situations,
or if you are ahead late in the game. But
you will want plenty of options at any one
time. It's always best to keep the defense
guessing.

RISK-GAIN

The plays in the Offensive Playcard belong
to five “‘Risk-Gain”’ (RG) categories: Short,
Medium, Sting, Long, and Very Long.
Each category refers to a range of yardage
that the play attempts to gain. This range
also represents the risk of the play; the

wider the range of expected results, the
riskier the play.

Plays in the Sting category are
especially unpredictable and thus risky.
They are counterpunch plays designed to
succeed against specific defenses. If such
a defense is called, they will do well; if

In all cases the actual results will be
influenced by many factors, such as the
strengths and weaknesses of the two
teams, and the strategies crafted by their
coaches. There are many ways to devise a
strategy for victory in football, but in the
long run, practically anything goes.

not, the play could lose yardage.

These categories, of course, are only
guidelines. In reality, every play has a
unigue risk-gain combination. Moreover,
every play has in it a certain potential for a
loss as well as for a much bigger gain

than expected.

Risk-Gain (RG)
Category

Short

Medium

Sting

Long

Very Long

Attempted
Yardage

Oto3
2t07
0to 10
6 to 18
13 or more

OFFENSIVE PLAY GROUP 3 RED
Situation: Long yardage

Formations: Shotgun and Slot; some with a
third wide receiwver

1. Shotgun Draw Trap (Run) RG: Sting
2. Slot SS Rollout (Pass) RG: Long
Slot WS Flood (Pass) RG: Long
Shotgun SS Stack (Pass) RG: Long
Slot X.Y,Z In (Pass) RG: Long
Shotgun C Post (Pass) RG: V. Long
Shotgun SS Flood (Pass) RG: V. Long
Shotgun Y Cross (Pass) RG: V. Long

o NS ;e W

1. Shotgun Draw Trap

2.

Slot Strongside Rollout Pass

........
e & |

Slot Weakside Flood

5. stXx, Y, ZIn

e
s

7. shotgun Strongside Flood

B
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8. shotgun Y Cross

OFFENSIVE PLAY GROUP 4 GREEN
SPECIAL PLAYS

Cituations: Fourth down or two-minute mode

Formation: Various

1. Punt
2. Field Goal

3. QB Downs Ball

4. QB Throws Ball Away

NOTE: There are no play diagrams for these plays.

Kickoffs:

1. Normal kick
2. Onside kick
3. Squib kick

Fourth Down:

1. Go for it
2. Punt
3. Field Goal

KICKOFF AND FOURTH DOWN SITUATIONS

MNOTE: There are no play diagrams for these plays.




Defense: Introduction

Defenses in the NFL vary widely in a con-
tinuing attempt to keep offenses off
balance. To represent this variety, the PRO
Challenge Defensive Playcard contains
plays based on both of the classic defen-
sive formations in broad use: the 3-4, and
the 4-3. The Playcards also contain a
variety of short-yardage and long-yardage
defenses. Against runs, the position of the

front linemen and the assignments of the
linebackers will determine where the
strong points,.as well as the holes, in the
defense will be. Against passes, the
number of pass rushers and the type of
pass coverage used are the most impor-
tant factors.

Zone coverages are safer against many
passes than Man-to-Man coverages,

because they are less likely to allow a
receiver to break deep; Man-to-Man
coverages, however, are less susceptible to
flood passes and in general apply more
pressure on the receivers.

For zone coverages, a fifth (nickel) or
sixth (dime) defensive back improves pass
coverage considerably. Blitzes can also be
an effective tool against long passes.

DEFENSIVE PLAY GROUP 1 PURPLE

Zone
Zone

1. 4-3 Under Zone

2. 4-4 Buck Strong
3. 4-3 Under Strong Safety Blitz Man-to-Man

1. 4-3 Under Zone

.i.H.‘-
e

2. 4-4 Buck Strong

ld i & ml

e i ade
6. 20 Over Stack Zone
7. Sam and Will Blitz Man-to-Man
3. 4-3 Under Strong Safety Blitz 4. 20 Five Under
I & 14
f/'i* o A e N
. ! !
5. 20 Three Deep 6. 20 Over Stack 7. sam and Will Biitz
[d & 4 lirk) Z &S\
i A . ¢ e

! ’ !

S !

DEFENSIVE PLAY GROUP 2 WIHITE

1. 30 Willy Zone
2. Over Twist Willy Zone
3. 10 Blitz Man Man-to-Man
4. 11 Blitz Slot Man Man-to-Man
5. 3-4 Will Out Nickel Zone

6. 3-4 Man Under Dime Both
7. 4-3 Over Free Safety Blitz Man-to-Man

2., Over Twist Willy

5). 3-a4 Will Out Nickel

IR
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@n 3-4 Man Under Dime

AN

7. 43 Over Free Safety Blitz
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XOR

CORPORATION

5421 OPPORTUNITY COUAT
MINNETONKA, MN 55343
(612) 938-0005

Dear PRO Challenge User,

Congratulations on purchasing PRO Challenge!

PRO Challenge is the “‘coaching’ version of our NFL Challenge, the most complete football simulation
ever devised. We decided to produce PRO Challenge after many requests for a product that puts the
emphasis directly on a person’s offensive and defensive play calling skill. With this in mind, the two teams
provided with PRO Challenge are identical and consist of our selections from the ALL-NFL team.

Digital lllusions, Inc. adapted the original IBM version to run on the Apple Macintosh. They added several
enhancements to the program to take full advantage of Macintosh capabilities.

For your convenience, we have chosen not to copy protect PRO Challenge. Take time to read the legal
agreement in this User’s Guide. Notice that we encourage you to make backup copies of your Program and
Team disks.

PRO Challenge will give you many hours of enjoyment. Please note that a full value TRADE-IN form is
included in your PRO Challenge box. You can apply that TRADE-IN at any time toward the purchase of NFL
Challenge, ordered directly from XOR Corporation.

On behalf of the staff at XOR Corporation, thanks for your support in purchasing our product. Please send
in your Product Registration Card in order to receive information on special promotions and new product
announcements.

Enjoy PRO Challenge!

Sincerely,

ot D.

Robert D. Krutz
President and CEO



NOTICE TO USER

This software product consisting of the PRO Challenge Program Disk, the PRO Challenge Team Disk, two Offensive and Defensive
Playcards, and the accompanying User's Guide (collectively the “Software”') is the copyrighted property of XOR Corporation and is licensed
to User, as hereinafter defined, on the condition that User agrees to the terms of the following License. READ THIS LICENSE CAREFULLY.
If you do not agree to the terms of this License, you should return the entire package and its complete contents, with the diskette envelope
unopened, to Place of Purchase for refund of the license fee. Proof of payment, including place of payment, date of payment, and the
amount paid, must accompany any such return. Opening the diskette envelope constitutes acceptance of the terms of this License. For
purposes hereof, “'User'"” means the person who originally acquires the Software from XOR Corporation or an Authorized XOR Software
Dealer ("'Dealer”).

XOR CORPORATION SOFTWARE LICENSE

XOR Corporation grants to User a nontransferrable, nonassignable, nonexclusive license to use the Software. In the event User's computer
is or becomes capable of allowing multiple terminals to access common disk memaory, User shall pay a separate license fee for each
terminal with such access.

MNeither the Software nor this License may be transferred, assigned, or sublicensed without the prior written permission of XOR
Corporation. Except as otherwise described in this License, User shall not copy, print or otherwise provide access to the Software, except (1)
on a 3'a-inch diskette copy for backup purposes; or (2) on a hard disk drive used exclusively by User. User shall not permit the Software to
be copied, printed, or accessed by others. User shall not disassemble, decompile, or otherwise attempt to “reverse engineer”’ the Software,
nor shall User permit any other person to do so.

User is hereby granted the limited right to edit or change the team roster or player statistics residing on the PRO Challenge Team Disk;
provided, however, that User shall not license, sublicense, sell, or otherwise transfer any such edited or changed diskette to any other

person.

DISCLAIMER OF SOFTWARE WARRANTIES AND LIABILITIES
THE SOFTWARE IS FURNISHED “AS I1S” WITHOUT WARRANTIES OF ANY KIND, EITHER EXPRESSED OR IMPLIED. ALL
WARRANTIES OF MERCHANTABILITY OF THE SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE ARE SPECIFICALLY
EXCLUDED AND DISCLAIMED. USER BEARS THE ENTIRE RISK RELATING TO THE QUALITY AND PERFORMANCE OF THE
SOFTWARE AND IN NO EVENT IS XOR CORPORATION LIABLE FOR DIRECT, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES RESULTING FROM ANY DEFECT IN.-THE SOFTWARE. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION
OF IMPLIED WARRANTIES OR LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR
EXCLUSICN MAY NOT APPLY TO YOU. XOR CORPORATION DOES NOT WARRANT THE FUNCTIONS CONTAINED IN THE
SOFTWARE WILL MEET USER'S REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR
ERROR FREE.

The Software is intended for entertainment use only and, although every attempt has been made to include an accurate roster and player
statistics on the PRO Challenge Team Disk, XOR makes no warranty or representation that such roster or statistics are error-free.

ONE YEAR LIMITED WARRANTY ON DISKETTES AND LIMITATION OF REMEDIES

XOR Corporation warrants to User only that the diskettes on which the Software is furnished will be free from defects in materials and
workmanship under normal use for a period of one (1) year from the date of delivery to User. The entire liability of XOR Corporation with
respect to the limited warranty on the diskettes, and User’s exclusive remedies shall be:

1. The replacement of any diskettes that exhibits a defect in materials or workmanship under normal use and that—

a. Within ninety (90) days from the date of delivery to User, the diskette is returned to XOR Corporation or Dealer together with a
copy of User's receipt.

b. More than ninety (90) days but within one (1) year from the date of delivery to User, the diskette is returned to XOR Corporation
together with a copy of User's receipt and $5.00 to cover postage and handling; or

2. If XOR Corporation or Dealer is unable to furnish a replacement diskette that is free of defects in materials and workmanship, User may

return the Software to XOR Corporation, together with a copy of User’'s receipt, and the license fee will be refunded.

This warranty gives you specific legal rights, and you may have other rights which vary from state to state.

ANY IMPLIED WARRANTY OF MERCHANTABILITY OF THE DISKETTES OR THEIR FITNESS FOR ANY PARTICULAR PURPOSE 1S
SPECIFICALLY LIMITED IN DURATION TO A PERIOD OF ONE (1) YEAR FROM THE DATE OF DELIVERY TO USER. IN NO EVENT
WILL XOR CORPORATION BE LIABLE FOR ANY LOST PROFITS, LOST SAVINGS, OR OTHER CONSEQUENTIAL OR INCIDENTAL
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE DISKETTES, EVEN IF XOR CORPORATION OR DEALER HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF
LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

GENERAL
This License is the complete and exclusive statement of the Agreement between XOR Corporation and User. This License and the

respective rights, duties, obligations, and liabilities of XOR Corporation and User will be governed by the laws of the State of Minnesota.
If you have any questions concerning this License, write to XOR Corporation, Sales and Service, 5421 Opportunity Court, Minnetonka,
Minnesota 55343,

NOTICE TO USER REGARDING APPLE COMPUTER, INC. SOFTWARE
APPLE COMPUTER, INC. MAKES NO WARRANTIES, EITHER EXPRESS OR IMPLIED, REGARDING THE ENCLOSED COMPUTER
SOFTWARE PACKAGE, ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED
WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY
PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE
TO STATE.

The SYSTEM SOFTWARE and MACINTALK are copyrighted programs of Apple Computer, Inc. licensed to XOR Corporation to distribute
for use only in combination with PRO Challenge. Apple software shall not be copied onto another diskette (except for archive purposes) or
into memory unless as part of the execution of PRO Challenge. When PRO Challenge has completed execution, Apple software shall not be

used by any other program.
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PART |—Introduction

This User's Guide is designed to help you begin enjoying PRO Challenge as quickly as possible.
Although we hope that you take the time to explore the many features that make PRO Challenge power-
ful and versatile, we know that the best way we can convince you to do so is to get you playing PRO
Challenge. Part Il of this guide does exactly that—it goes through PRO Challenge step by step, pro-
viding you with just what you need to know to play.

If you choose to wait until later to step through the tutorial, you can still run the program as a self-
running simulation. You will need to read at least the rest of this section and steps 1 through 4 of Part l|
as a minimum.

PRO Challenge is full of features which are not absolutely necessary to know to play the game, but
which you might find interesting nonetheless. These features are described in Part Il of this guide.

In order to play and understand PRO Challenge properly, it is necessary to make use of the Offen-
sive/Defensive Playcards provided. The Playcards describe every offensive or defensive play you can call

in PRO Challenge.

BEFORE YOU START . ..

If every computer system were the same, the job of explaining how to run a program would be a lot
simpler. Computer systems come in all shapes and sizes, however, and before we can show you how to
run PRO Challenge we need to address the question of hardware.

The version of PRO Challenge which you have is the Apple* Macintosht version which can operate
on the Macintosh 512K, Macintosh XL, Macintosh Plus, and Macintosh SE computers.

Two things, however, are absolutely necessary to run this program:
1. At least one 3'2-inch disk drive.
2. At least 512K bytes of internal memory.
For optimal results, your computer system should have the following (although it is not absolutely
necessary):
3. Two 3V2-inch disk drives or one 3'2-inch and one hard disk drive.
4. A numeric keypad either as part of the keyboard (like the Macintosh Plus), or an external
numeric keypad.

If you don't have two disk drives, you can still run the program, but you will have to do some disk
swapping. PRO Challenge uses two 3'z-inch diskettes, labeled ‘‘Program Disk’ and ““Team Disk™. Most
of the time the Program Disk needs to be in the drive, and the program will tell you when you must
replace it with the Team Disk.

* Apple is a registered trademark of Apple Computer, Inc.
t Macintosh is a trademark of Apple Computer, Inc.

Page 3



PART II—Step Through
Installation and Tutorial

INSTALLATION

STEP 1: Preparation

PRO Challenge comes on two 3'2-inch diskettes, the Program Disk and the Team Disk. These diskettes
are not copy protected, and we authorize you to make a copy of each diskette for backup purposes. We
also authorize you to copy the contents of either or both diskettes onto a hard disk if you have one.
Doing so is not necessary, but will slightly reduce the time required to load and run the program.

STEP 2: Getting Started

Without any further pregame instructions, let's get PRO Challenge up and running. Turn on your
computer, and make sure you have both PRO Challenge diskettes—the Program Disk and the Team
Disk. For your convenience, the System file has been placed on the PRO Challenge Program Disk. Your
next step depends on the kind of disk drives you have:

ONE 400K 32-INCH DISK DRIVE: Place the Program Disk in the internal drive.

TWO 400K 3'2-INCH DISK DRIVES: Place the Program Disk in the internal drive and the
Team Disk in the external drive.

ONE 800K 3'2-INCH DISK DRIVE: Copy all of the files/folders from both Program and Team disks
onto one 800K initialized diskette. This eliminates the need for disk swapping.

ONE 3'2-INCH AND ONE HARD DISK DRIVE:

e MFS (Macintosh File System): Copy the PRO Challenge file and the PRO DATA folder to
your hard disk. Do NOT copy the System file from the Program disk to your hard disk. Only
copy the MacinTalk file to your hard disk if you do not have Macinfalk on your hard disk
already.

e HFS (Hierarchical File System): Follow the instructions above for an MFS hard disk drive
with the following restrictions:
(1) All of the PRO Challenge files/folders must reside in the same folder on your hard disk.
(2) Do NOT change the PRO DATA name.
(3) Do NOT move the Data or Team files from the PRO DATA folder.

Next, double-click on the PRO icon on your 800K disk or your hard disk to start PRO Challenge
running.

The screen will clear, you will see an opening display, then the PRO Challenge Startup screen will
appear. The Apple and File headings of the menu bar will be present. The File menu will include the
New, Open, and Quit options, which allow you to Start a new game, Open a saved game, or Quit PRO
Challenge.

BEGINNING A NEW GAME
Choose the New option from the File menu to start a new game.

STEP 3: The teams

The two teams provided with PRO Challenge are called the All Stars and the All Pros. The players on
the two teams are identical and consist of selections from the ALL-NFL team. The visiting team will
always be the All Pros and the home team will always be the All Stars. Having two identical teams
allows the emphasis to be placed on the offensive and defensive play selection.

Page 4



STEP 4: Choosing coaches and keyboard sides
The Program will ask you to choose a coach and keyboard side for each team. First let's explain what
this means.

One way to play PRO Challenge is with two people, one person being the coach of one team and the
other person being the coach of the other team. But you also can play by yourself if you want to, in
which case you are the coach of one team and the computer is the coach of the other team. You can
even let the computer control both teams, in which case you are simply a spectator.

When both sides have human coaches, each team has one of three possible keyboard configurations
associated with it. The actual ‘keys’ for each side depend on the keyboard configuration of the computer
and will be described later. A computer coach never needs a configuration because it has its own way
to make decisions. PRO Challenge lets you switch between a computer coach and a human coach at
any point in the game.

The keyboard side (right or left) also determines which side of the screen (right or left) the program
will display certain information such as lists of plays to select from.

Now that you understand the choices, select the keyboard side for the home team by clicking either
the Left or Right button. The visiting team automatically gets the other keyboard side. Then select a
“human’ or “‘computer’’ coach for the home team by clicking on the Human or Computer button.
Finally, select the coach for the visiting team by again clicking on either the Human or Computer
button. If you make a mistake or change your mind, just click on the Cancel button.

We recommend that the first time through you select a human coach for at least one of the teams.
Otherwise, the computer will do everything and you won't have a chance to learn how to play the game
yourself! If, on the other hand, you do not want to learn how to play the game yourself right now, you
can select the computer to be the coach for both teams, put down this guide, and enjoy the show.

SELF RUNNING SIMULATION
As noted above, if you choose to have the computer coach both teams, you will become a spectator of

the game. This is the SELF-RUNNING SIMULATION.
To QUIT the simulation, select the Quit option from the File menu.

TUTORIAL A
STEP 5: The coin toss
As in the NFL, before every football game there is a coin toss. So the program now will ask the coach

of the visiting team to call the toss. If you (or another human) are the coach, you must click on either
the Heads or Tails button. If the computer is the coach, it will call the toss automatically.

Next, you will see a simulated coin flip which will result in either heads or tails. The team winning the
toss now elects whether to kick or receive. A human coach must make this decision by clicking on
either the Kick or Receive button. If the coach is the computer, the choice will be made automatically
and will be, naturally, to receive.

STEP 6: While we're waiting .

At this point in the simulation, the program has to load a iarge amount of data, such as play lists, team
rosters, statistical information, and so on. This takes a short while. But we can take advantage of the
pause in the action by explaining some things that will come in handy very soon.
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A FEW IMPORTANT KEYS TO KNOW ABOUT:

Many decisions in the game are made by choosing options from windows. You can select such options
using the mouse or the keyboard. We talked a bit about the keyboard sides in Step 4 above, but there
IS more you must know.

Remember that there are two keyboard sides, the right and the left. When both sides have human
coaches, each team has one of three possible keyboard configurations associated with it. The
configurations are referred to as Configuration A, Configuration B, and Configuration C. Configurations A
and B are for keys on the keyboard and numeric keypad, respectively, while Configuration C is for the
mouse. (See Figure 1. Keyboard Configuration.)

& Keyboard Configuration ‘
[lg

Left Coach Choose Configuration:

@ A - Top Row Number Keys
() B - Numeric Keypad (if available)
() C - Mouse

[ Right Coach | [ OK | [ cancel |

Figure 1. Keyboard Configuration

When one coach is human and the other is computer, the human coach can use any configuration
desired. Any time you see a window appear that has options with numbers next to them, you can select
an option with the ten number keys (1 to 9, 0) of your configuration. No window ever has more than ten
options. The number keys for Configuration A and B are listed below:

Configuration A: The “number’ keys for Keypad A are the numbered keys on the top row of the
keyboard and a telephone-like number pad formed from the left side of the keyboard. This second
subset of keys is as follows: [1], [2], [3], [Q], [W], [E], [A], [S], [D], and [X]. The “number” keys 1, 2,
and 3 are the same in both subsets.

Configuration B: The “number” keys for Keypad B are the number keys on the numeric keypad. Note:
Keypad B is only available when the computer system has a numeric keypad (i.e., Macintosh Plus
keyboard or external numeric keypad).

In addition to the number keys, we will be referring to the ‘“Cancel key”” and the “Return key'' for
each keyboard side. The Cancel key allows you to change your mind in many cases after you have

made a decision.
The Cancel and Return keys are as follows: For the left keyboard side, the Cancel key is the tilde [~]

key (the one in the top left corner) and the Return key is the [Tab] key. For the right keyboard side, the
Cancel key is the [Backspace] key and the Return key is the [Return] key. For the numeric keypad, the
Cancel key is the [Clear] key and the Return key is the [Enter] key.

There is one more important key belonging to each keyboard side, called the “Coaching™ key. This Is
the key each player can use to make coaching decisions such as calling time outs. The Coaching Key
for the left keyboard side is the [Z] key; and for the right keyboard side is the normal slash [/ ] key. For
the numeric keypad, the Coaching key is also the normal slash [ /] key. The equivalent menu bar
options are found in the Game menu.
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Finally, there are two more things which are good to know how to do in PRO Challenge as in any
program.

To QUIT the program in the middle of the game, select the Quit option from the File menu (there is
no keyboard equivalent command).

To FREEZE the game at any point, select the Freeze option from the Game menu or press the [cmd]
F combination. To continue, either select the Continue option from the File menu or press any key to
start the action again.

The program should be ready by now, so let's continue with the game.

STEP 7: Just before kickoff

When the program has loaded all its data and is ready to continue, you will see several things appear
on the screen. At the top you will see the scoreboard, which throughout the game will display all
important status information, such as game time, the quarter, the score, time outs remaining, the line of
scrimmage, the down, yards to go, and the thirty-second clock.

After the start of the game, you will see the following: Next to the name of one of the teams there will
be a little marker, This marker indicates which team has possession of the ball; at the start of the game,
accordingly, it will be next to the kicking team. In the middle of the screen you will see a representation
of the field. A triangle on the field will keep track of the location of the ball and the direction of play.
Other markers directly above the field will indicate the yard line required for a first down.

STEP 8: Opening kickoff

The opening kickoff brings the first play selection window of the game to the screen. It is a simple
window with three choices—Normal Kick, Squib Kick, and Onside Kick. As soon as this window
appears, the thirty-second clock, located at the top right corner of the screen, will begin to tick. Now is
a good time to introduce a very important feature for beginners (not football beginners, PRO Challenge
beginners). It is called Learn mode, and you should activate it inmediately by selecting the Learn option
from the Options menu or by pressing the [cmd] L key combination. You will see the message "“Enter
Learn mode’’ appear at the bottom of the screen.

Learn mode doesn’t cause anything to happen, rather it prevents something from happening, namely
delay of game penalities. Normally, in PRO Challenge, as in real football, if you let the thirty-second
clock tick down to zero, you are assessed a penalty for delay of game. Learn mode restrains the referee
and allows you to take as long as you want to select a play. This will give you a chance to figure out
what's going on—and us a chance to explain it to you.

Now back to the kickoff window. If the kicking team is coached by the computer, it will already have
made its selection by now. If a human is the coach, make a selection using the mouse or the proper
key. You will know when the selection is made: you will hear a sound indicating that the play has been
selected, and you will see a message appear directly below the field stating “Kickoff,” “Squib Kick," or
“Onside Kick.’ depending on which kickoff play was selected. Then you will see the little triangle
representing the ball move downfield toward the receiving team’s end zone. Once the ball stops, a
message at the bottom will indicate the exact yardage of the kickoff. The ball will then turn around and
move upfield, representing the return. At the same time, the possession marker which was next to the
name of the kicking team on the scoreboard at the top of the screen will move to the other team,
indicating a change of possession. A message underneath the field will indicate the yardage gained on
the return.

The above series of events is not predetermined. A lot of things can happen on a kickoff, such as a
touchback, a penalty, or even a fumble. Whatever happens, though, will be clearly stated.

(If a penalty occurs, you might have to kick over, in which case you will again be presented with the
kickoff window. Another thing that happens with penalties in some cases is that you will see a window
asking you if you want to accept or decline the penalty. If so, make your choice using the mouse or
your keypad.)

After the kickoff and return have finished, the screen will be prepared for the first play from
scrimmage. The scoreboard will indicate the down (first) and the yard line. Directly above the field, the
first down markers will appear.
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STEP 9: Play selection

Now begins the process of offensive and defensive play selection. This differs from kickoff play selection
in a couple of ways. For one thing, two windows will appear, one for the defense and one for the
offense. For another thing, the options on these windows do not represent plays, but rather groups of
plays. It will require, therefore, two selections by each team to choose a play.

Try selecting an option on the play selection window for your team. You will see another window
appear above the first window and the selected play group will be highlighted. The options on this
window represent individual plays. The little dots after some of the play names on the offensive side
indicate pass plays (the rest are runs).

When using the mouse for play selection, you click on the desired play group to get the play selection
window to appear for that group. (Then you click on the desired play.)

Before you select a play, we want to show you something important—how to change your mind. If you
are using the mouse, just click on the currently selected play group or press your Cancel key (i.e., left
side use [~]; right side use [Backspace] - for more information about the Cancel keys, refer back to
step 6). The top window on your side will disappear and the selected play group window line will be
unhighlighted. You can now select any play group, even the same one over again, as you wish. Also,
when using the mouse, you can take a shortcut when changing play groups by simply clicking on a
different play group, and the new play selection window will appear. Similarly, you can click on a
different play, within a play group, providing you do so before your opponent has selected a play. You
can change your mind like this as much as you want, up until the point that both teams have selected a
play. Clicking on the currently selected play group window line or using the Cancel key can not only
take back a play group selection, but a specific play as well, provided the other coach has not selected
his play yet.

Normally, the thirty-second clock, ticking away in the upper right corner, makes it necessary to select
a play quickly. But since we are in Learn mode, we have the luxury of taking our time. (If you hear the
referee’s whistle and see a message indicating a delay of game penalty, it means that you are not in
Learn mode after all. In that case, just press the [cmd] L key combination.

In normal play (that is, not in Learn mode), if the offensive coach fails to select a play before the
thirty-second clock runs out, his team is assessed a delay of game penalty. If the defensive coach fails
to make a selection, no penalty is called, because in real football the defense can get caught
unprepared. What happens in PRO Challenge is that whatever defensive play was called on the last
play is automatically selected again for the defense by the program.

Go ahead now and select a play. If you are the offensive coach, for the moment do not select a play
from Group 4, which is labeled ‘‘Special Group.” We will describe this group a little later, since it is
useful only in very special circumstances. Any other group will work fine for our present purpose.

Once you have picked both a group and a play within a group, a message will appear below the
bottom window indicating that a play has been selected. However, until both coaches have selected a
play, there will be no indication as to which particular play has been selected. Uncertainty is an
important aspect of football strategy.

Your opponent can clearly see, however, the play group to which your play belongs. This is realistic,
because the play groups correspond largely to formations, and in real football each team has a chance
to see the other team’s formation before the ball is snapped. Every group, moreover, contains a
significant variety of plays, so knowing just the play group is not necessarily very helpful. For those who
want complete uncertainty, PRO Challenge has an option allowing complete suppression of play
selection windows, which we describe in Part lll of this guide.

STEP 10: Play results

Let's see what happens after both coaches have made their play selections. First, you will see the
names of the selected plays in the windows on each side become highlighted. These play names also
appear directly underneath the field in the play result message area. Then you will hear the same sort
of sound you heard at the kickoff, indicating that the play is about to be simulated. What you see next
depends on whether you have the Graphics option selected, or not.
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WITH GRAPHICS

If you have graphics selected, the screen will clear and a close-up of part of the field will appear.
You will see the offense represented by O’s and the defense represented by X’s. The field will be
marked with hashmarks every yard, solid lines every five yards, and numbers every ten yards. The
ball will be positioned at the line of scrimmage. You won't be able to see the sidelines yet, but
they are just off either edge of the screen. One other marker will probably also be in view—a gray
line indicating the yard line which the offense must get to for a first down. (If the offense needs
fifteen or more yards for a first down, the first down line will be off the screen.)

The offensive team will break out of its huddle and line up in its formation. After a moment, the
ball will be snapped and the play will come to life. You will see the X's and the O’s block and run
and cover and tackle—depending, of course, on the plays that were called as well as all the other
factors that are part of the simulation.

If the play goes far enough downfield or towards the sideline, the view will shift to follow the
ball. Eventually the play will end, either with a tackle, an incomplete pass, the ball carrier going
out of bounds, or the ball carrier scoring.

After the play has run its course, if you have instant replay toggled on, you will see it happen
over again exactly as before, except in slow motion. To exit either type of animation, just press
your cancel key.

Following the graphic animation of the play, the screen will clear, and the main screen with the
scoreboard and the whole field will reappear.

WITHOUT GRAPHICS

If you do not have graphics selected, you will see the triangle representing the ball on the screen
move to the right or the left (i.e., up or down the field) according to the results of the play. The
messages described below will appear at the same time.

With or without graphics, the exact results of the play will then be reported in the results message
area directly underneath the field. The message will include information such as what kind of play was
run (run or pass), who carried the ball, how many yards were gained, who made the tackle, and any
other important things that may have happened, such as a fumble, an interception, a touchdown, and so
on.

PRO Challenge also has special graphic screens for scoring plays and turnovers.

After all the play results have been reported, the scoreboard display will be updated to reflect the new
yard line, down, time on the clock, and anything else that may have changed. The play selection

process then begins again.

STEP 11: Fourth Down and Special Group plays
As the game continues, sooner or later you will be faced with fourth down. At this point, you must make

a decision: should you punt, try a field goal, or go for it? These options are presented to the offensive
coach on fourth down in a window that comes up instead of the play selection windows. If the offensive
coach elects to go for it, the normal play group windows come up and play selection proceeds as on
any other down. If the offensive coach chooses either to punt or attempt a field goal, the chosen action
occurs immediately. No further selection is required by the offensive coach, and no selection at all is
required by the defensive coach.

For punts and field goals, as well as kickoffs and other special team plays, the program provides no
graphic animation. You will see the ball marker move up or down the field to represent both kicks and
returns. You also will see results reported in the message area underneath the field as for any play.
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Punts and field goals are accessible on any down. The last option on the offensive play group
window, labeled “'Special Group,” brings up a window allowing the offensive coach to punt or try a field
goal on any down. In practice, a field goal attempt before fourth down is likely to be desirable only at
the very end of the game or the half, when enough time remains for only one more play. Punts before
the fourth down are unlikely to be useful ever, but the rules of football allow it, so PRO Challenge does
as well.

Also in the Special Group are two other plays intended for use at the end of the game or half. These
are called "QB Throws Ball Away’' and ““QB Downs Ball.” Throw Away is a play which stops the clock
on an intentionally incomplete pass. QB Downs Ball calls for the quarterback to fall on the ball
immediately after the snap, minimizing the chance of a fumble and keeping the clock running while
losing a yard. Neither of these plays are depicted by the animated graphics.

STEP 12: Penalties

Two types of penalties exist in football: a penalty that occurs before a play, which is always charged
against the team that commits it, and a penalty that occurs during a play, which is charged only if the
other team accepts the penalty.

When pre-play penalties occur, a whistle blows and a window with all the penalty information appears.
The yardage is walked off, and the play selection process starts over again. When penalties occur
during the play, the program first shows the play and reports the results, then blows the whistle and
announces the penalty. If the non-offending team has a human coach, a window appears with two
options: accept or decline. If the coach accepts the penalty, the yards are walked off as indicated in the
penalty window and the play results described directly below the field are discarded. If the coach
declines the penalty, the play results become official.

On most penalties, the down remains the same. When a penalty involves an automatic first down or a
loss of a down, the message in the penalty window says so.

STEP 13: Coaching options
A human coach in PRO Challenge has access to a special window called the Coaching Window, which
allows him to call time outs, and to enter/exit ‘‘two-minute mode”’

As we mentioned in step 6, each keyboard side has a Coaching key. This is the key which brings up
the Coaching Window. The Cancel key for each keyboard side removes the Coaching Window. If the
mouse is being used to select plays, the Coaching Window can be removed by clicking on the lower
play selection window.

Take a look at your Coaching Window now. Just after the program brings up the play selection
windows, select the Coach option from the Game menu or press the coaching key for your keyboard
side. A window will appear on your side of the screen listing ““Two Minute Mode,” and “‘Time Out.”

Try selecting option 2, Time Out. If you have at least one time out left, the main clock and the thirty-
second clock will both stop, and a window will appear announcing the time out. Also, the number of
time outs listed on the scoreboard for your team will decrease by one.

The time out remains in effect until both teams have selected their next plays. You can use a time out
to go over the play groups, or simply stop the clock. Each team is allotted three time outs in each half
of the game (and in the overtime period as well, should the game end in a tie).

Now select option 1, Two-Minute Mode. A message will appear at the bottom of the screen stating,
“Enter Two-Minute Mode.” If your team has the ball, the possession marker next to your team’s name
on the scoreboard will become hollow. This is the signal that a team is in two-minute mode.

Two-minute mode only affects the offense. In the NFL it is sometimes known as the “hurry up”
offense. When a team is in two-minute mode, all ball carriers on that team will make a special effort to
get out of bounds and stop the clock. The quarterback will take more chances with his passes, resulting
in longer completions but with a higher risk of interception.
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A computer coach will put its team into two-minute mode as called for by the time remaining in the
game and the score, which could be at the two-minute warning, before it, after it, or never. Similarly, a
human coach can do the same. No message will appear for the computer coach, but the possession
marker on the scoreboard will become hollow.

Select two-minute mode again. This time a message will appear stating “'Exit Two-Minute Mode.” You
can enter and exit two-minute mode at any time and as often as you wish.

TUTORIAL B

STEP 14: Quarters, halftime, and after the game

When the clock runs out at the end of the first and third quarters, the program automatically switches
sides for the teams. Only the direction of play is switched, not the keyboard sides. The teams retain
their keyboard sides for the entire game.

At halftime, the program automatically displays statistical results for the first half. Included are all-
important team statistics, such as first downs, yards gained, and time of possession. Then, before the
second half begins, the program gives human coaches a chance to indicate they are ready to start the
game. Computer coaches are always ready, so as soon as all human coaches give the signal, the
second half begins.

The second half proceeds just like the first. If, at the end of the fourth quarter, the score is tied, the
game goes into sudden death overtime, just like in the NFL. “Sudden death” means that whoever
scores first from that point on wins the game. The overtime period begins with a kickoff; the team that
gets to receive is selected randomly by the computer. (In real football it is settled by a coin toss.) The
game will proceed until one team or the other scores. If the game is still tied at the end of the overtime
period, and the computer is playing both sides, the game ends. Otherwise, a dialog box appears with
the question ‘‘Another Sudden Death Quarter?”’; click the OK button to play another quarter.

As soon as the game comes to an end, the program displays the final statistics for both teams. After
that, if you desire, the program lets you have something right away which other coaches must wait for: a
rematch.

STEP 15: The next time you run the program

As you may remember from step 6, you have the ability to change the keyboard configuration using the
Keyboard option from the Configuration menu. If you made any changes, they were stored at that time.
The next time you run the program, the program will begin with your customized PRO Challenge

keyboard configuration.
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PART Illl — Special Features
and Options

If you have gone through the step-by-step instructions in Part Il of this User's Guide, then you have
been exposed to several of the features and options in PRO Challenge. There are many other features
in the program, some small and some very powerful, and in this part we will describe them one by one.

Every feature we describe below is activated through the menu bar. In addition, some features have
keyboard equivalents.

A note on all features: Because PRO Challenge is a complex program and must do many things,
there are times when the program will be occupied by an activity which prevents some of the
commands described below from taking effect. You will know when a command is accepted by a
message on the screen indicating the action taken by the program.

In addition, when a feature is turned on, a check mark is placed at the beginning of the menu item

under the Options menu.
1. Quit, New game, and Freeze

File menu: Quit=Quit the program.
File menu: New=New game.
Game menu: Freeze/Continue=Freeze the game, [cmd] F.

You can exit the game at any point. If you are in the middle of a game, however, it will be lost, unless
you specifically save it (see “Saving and Restoring games,’ below). As a safety feature, therefore, the
program gives you a chance to change your mind before exiting. When you choose Quit, the question
“Quit PRO Challenge?’’ appears in a dialog box; if you click the OK button, the program exits.

Another useful feature of PRO Challenge is the ability to start a game over. Choosing the New option,
for “New game,’ activates this feature. Similar to the Quit option, the New option, as a safety feature,
allows you to change your mind before the current game is lost.

Choosing Freeze at any point freezes all action until you select the Continue option or press any key.

2. Changing coaches and personas

Before the game started, you decided who would be the coach of each team, either a human or the
computer. PRO Challenge allows you to switch coaches as often and whenever you want. If two people
are playing, for instance, the game need not end if one person leaves; that person can simply turn over
the coaching job to the computer. Likewise, if you are watching two computer coaches go at it and
decide you want to participate, you can take control of one (or both) of the teams yourself.

The program provides three different kinds of computer coaches: Conservative, Balanced, and
Aggressive. A computer-controlled team, moreover, really has two coaches: one for offense and one for
defense. Thus, there are a total of nine possible combinations for a given team.

In addition, each computer coach has two levels of persona expertise, normal and advanced. The
“Normal’’ level selects plays under a coaching persona based on the game time, quarter, score, time
outs remaining, line of scrimmage, down, and yards to go. The “Advanced” level, in addition to the
above, takes into account the player’s skill numbers and the offensive and defensive play calling trends
of the opposing coach.

Each kind of coach, or “persona,” uses a particular strategy in selecting plays and making other
decisions. On offense, the difference lies primarily in the mix of running and passing plays the coach
will call. A Conservative offensive coach will call more running plays, an Aggressive offensive coach will
call more passing plays, and a Balanced offensive coach will be somewhere in between. On defense,
the three personas differ both in the formations they use and the kinds of plays they call. A
Conservative defensive coach will rely on the 3-4 formation and call plays such as zone defenses that
are less likely to result in a big break for either the offense or the defense. An Aggressive defensive
coach, on the other hand, will use the 4-3 formation and call more blitzes, a riskier strategy. Again, a
Balanced defensive coach will be somewhere in between, using both the 3-4 and 4-3 formations.
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The two teams in PRO Challenge have the same offensive and defensive persona. If you select a
computer coach for a team, the default persona combination will automatically be used; you can,
however, change the personas to whatever combination you want.

Changing between computer and human coach, and among the personas if the coach is the
computer, are all accomplished through the same feature:

Configuration menu: Coach=Change Coaches.

Choosing Coach causes the game to freeze and a dialog box to appear in the middle of the screen.
This window, the coaching configuration window, displays the current coach for each team. If the
computer is the coach for a team, the window also displays the offensive and defensive coaching
personas and the expertise level comprising the computer coach for that team.

With the coaching configuration window up, you can change the coaches and personas (including the
expertise level) for either or both teams. The dialog box consists of four sets of radio buttons which
allow you to set the coach, offensive persona, defensive persona, and the persona expertise level for
both Home and Visiting teams.

You can make as many changes as you want, for either or both teams, but you only can change the
personas for a team when the coach of that team is the computer (the personas don't have any effect if
a human is making the decisions). When you are finished, click on the OK button to confirm or the
Cancel button to disregard the changes; the window will disappear and the game will continue.

3. Delay speed and Extra-fast mode
PRO Challenge lets you change the speed at which the game progresses in two ways. One is a small
adjustment and the other is a radical change.

Configuration menu: Delay Speed=Delay Speed adjustment.
Options menu: Extra Fast=Extra-fast mode on/off, [cmd] E.

The delay speed is the amount of time that messages are displayed on the screen. There are three
delay speeds available. Slow, Normal, and Fast. The program begins at Normal speed. If you find that
you do not have time to read the messages, or if you find that you have more time than you need, you
may want to change the delay speed by choosing Delay Speed. The program will then display a dialog
box showing the three possible modes. The current state will be selected. At this point you can change
the delay speed by clicking on the appropriate radio button. When you are finished, click the OK button
to confirm or the Cancel button to disregard the changes, the window will disappear and the game will
continue.

If you want to speed up the game by more than just a little, instead of choosing Delay Speed you
can choose Extra Fast, which puts the program into a state called Extra-fast mode. Extra-fast mode
speeds up the game by practically eliminating all pauses, by bypassing certain features such as graphic
play animation, play selection windows, and special displays for touchdowns and field goals, and by
putting the computer in control of both teams, regardless of whether their coaches are human or not.
Use [Option] X for Extra Extra Fast mode.

Once the program is put into Extra-fast mode, the game will proceed very quickly (less than ten
minutes for an entire game on the average).

You can exit Extra-fast mode by choosing Extra Fast again. The program will return to whatever delay
speed, coaches (human or computer), and other options that were in effect before you entered Extra-fast
mode.
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4. Graphics and Instant replay

If the Graphics option is selected, the program will display animated graphics for most plays (no
graphics are displayed for punts and kicks). This is called graphics mode.

When the program is in graphics mode with Instant Replay selected, it shows the animated depiction
of each play twice: once at normal speed, and again in slow motion. The second time through is the
instant replay.

You can avoid the animated graphics, entirely, or you can see the graphics but just avoid the instant
replay.

Options menu: Graphics=Graphics mode on/off, [cmd] G.
Options menu: Instant Replay=Instant replay on/off, [emd] .

These options work like switches: every time you choose one, the state changes. For either option, a
message will appear at the bottom of the screen indicating the effect. When the program initially starts
with a human coach, the Graphics mode is on and the Instant Replay option is off. If the computer is
playing both sides, then the Instant Replay option is also on.

The play graphics resemble an animated playbook: X's and O'’s representing the two teams line up in
the proper formations, then move into action when the ball is snapped. While the animated graphics are
actually running, the mouse and most of the keys that activate various features in the program are
disabled, while some other keys have certain effects only during the graphics. The following list
describes all the keys that work during the actual running of the graphics and the functions they
perform. Where two keys are listed for a single function, they have identical effects.

[F] Freeze game until another key is pressed (same as outside the graphics, except
no message is displayed).

[~] [Backspace] (Cancel keys) Exit graphics immediately and return to main screen.
[Clear]

[Tab] [Return] (Return keys) Show the play again. If pressed during the first running of the play,
[Enter] this key ensures that the instant replay will be displayed, even if instant replay is
off. If pressed during the replay, this key causes another instant replay to be
displayed. You can repeat the instant replay as often as you want.

[Shift] [Shift] (Shift keys) Freeze frame. The animation freezes as long as either key is
depressed. You can use these keys to slow down the animation.

[ ] (Space bar) Hike/speed up. Normally, the players line up at the line of
scrimmage, they pause for about a second, and then the program snaps the ball
automatically to start the play. If you want to avoid the pause, you can snap the
ball manually by pressing this key. Also, this key causes the graphics to run in
fast motion as long as it is depressed.

The above keys are the only keys that have any effect while the graphics actually are running.

5. Saving and Restoring games

You will not always have enough time to finish an entire game without interruption. For this and other
reasons, PRO Challenge provides you with the ability to save games in progress and resume them at a
later time. Like any diskette files, such saved games are as permanent as you want them to be; you can
copy and erase them as well.
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A game can be saved at any time, even before it begins (but after the coin toss) or right after it ends.
When you eventually restore the game, it will begin at exactly the point at which you saved it, with the
original teams, score, time, and other relevant game factors.

The save and restore features are both found under the File menu.

File menu: Save=35ave the current game.
File menu: Open=Restore a previously saved game.

When you save a game, the program displays a standard file dialog box. A default file name is
provided as the ‘‘Visiting team name at Home team name” (e.g., All Pros at All Stars). As mentioned
above, choosing Open restores a previously saved game. Like the Save feature, the program displays a
standard file dialog box. Only PRO Challenge saved game files will be displayed in the dialog box.

When the program saves or restores a game, it saves or restores all the relevant aspects of the
football game itself. In addition to teams, score, and time, this includes the current down, yard line,
yards to go, time outs remaining, and all statistics. Also saved and restored are the coaches (human or
computer) and the coaching personas.

Most aspects of the program which are not part of the actual football game itself, however, are not
saved and restored with a game. This includes such things as the delay speed, the keyboard
configuration, and whether learn mode, graphics mode, instant replay, sound, etc. are on or off. None of
these really are part of the football game; they are just a part of the way you are using the program at
that time.

The save and restore features are active whenever you see the main PRO Challenge screen (i.e., the
screen with the File, Game, Configuration, and Options headings in the menu bar). You cannot save a
game until after the coin toss before the game.

There are a number of uses for the Save and Restore features besides just being able to interrupt a
game in the middle without losing it. The following is just a sampling:

e Going back to a certain point in a game: The Undo feature, described later in Part Ill, allows
you to see what might have happened on a play if you had tried a different strategy; that feature,
though, only lets you try one play over at a time. With the save and restore functions, you can
explore alternative strategies in depth. Let’s say, for example, that you are unsure whether to go
for it or punt in a particular fourth down situation. You can save the game before you decide,
continue the game with a punt, then eventually restore the game back to the decision point and

try going for it instead.

e Keeping a record of finished games: If you save a game immediately after it ends, the saved
game file will contain the period-by-period score and final statistics for the game, available for you
to review in the future if you should ever want to.

6. Sound and Speech
PRO Challenge employs sound and speech both to enhance enjoyment and make the program easier
to use. PRO Challenge allows both sound and speech to be turned off using a dialog box.

Configuration menu: Sound=Sound and/or Speech on/off.
The program starts with both the sound and speech features turned on. Choosing Sound displays the

sound configuration dialog box. This dialog box has three sets of radio buttons which control sound,
speech, and volume level. When you are finished, click on the OK button to confirm or the Cancel

button to disregard any change.
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7. Keyboard Configuration
Configuration menu: Keyboard = Keyboard Configuration.

This feature displays the current keyboard configuration for the ““number’’ keys on both the Left and
Right keyboard sides and allows the player to select one of three possible options. The options are
referred to as Configuration A, Configuration B, and Configuration C.

The program begins with Configuration A defaulted to the Left keyboard side and Configuration C
defaulted to the Right keyboard side when both sides are controlled by human players. If one side is
under human control and the other computer, then all three options are available to the human coach.
The computer doesn’t need to have one of the Configuration options assigned to it because it has its
own way to do play selection. Also, when changing coaches to human vs. human, the most recent
human vs. human configuration assignments are restored automatically.

If the initial human vs. human keyboard configuration does not meet your needs, you may change
the keyboard configuration. To do this, select the Keyboard menu item. The program will then display
the keyboard dialog box and ask for the left coach to choose either Configuration A, B, or C. The box
will show a picture of the keyboard with the three configurations shown on it. Below will be three radio
buttons, one for each option and the current choice will be selected. After the left coach is finished,
click on the Right Coach button. The dialog will now ask for the right coach to choose one of the
remaining configurations. Those options which are no longer available are grayed-out on the right coach
display. After both sides have been configured, click on the OK button to confirm, the Cancel button to
disregard changes, or the Left Coach to start keyboard configuration over again.

8. Statistical Results
PRO Challenge automatically displays team statistics for a game at halftime and immediately after the

game (see step 14 in Part Il). You also can examine the statistics at any other time you want.
Game menu: Statistics = Statistical results, [cmd] S.

Choosing Statistics causes the program to display a special screen showing complete statistics for
both teams up to that point in the game.

You can use this menu item as often as you want. If both teams are computer-controlled, the
statistics screen will automatically disappear after a few seconds and the game will continue unless the
Freeze menu item is quickly selected. (Note: the “Game Frozen” message is suppressed). Otherwise,
the statistics screen will remain until you click the mouse anywhere on the screen or press any key.
The game is frozen whenever the statistics screen is visible.

9. Learn mode
We described this important key once in Part ll, but it deserves mention again.

Options menu: Learn =Learn mode on/off, [cmd] L.

Learn mode prevents delay of game penalties from occurring, thus providing you with unlimited time
to select plays and ponder strategy. This mode is especially useful for those who are still learning how
to play PRO Challenge (hence the name), but it has other uses as well. In particular, it may be
appropriate for those whose interest in PRO Challenge is more in the area of strategy than in the
realism of the simulation.

You can enter and exit this mode as often as you want.
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10. Windows, Verbose messages, and Play names
PRO Challenge provides mechanisms for varying the amount of information provided during the course

of a game to suit your needs.

Configuration menu: Play Windows = show play windows.
Option menu: Verbose Messages =display verbose or terse messages, [emd] V.
Option menu: Play Names = Play names on/off, [cmd] P.

During offensive and defensive play selection, each coach first selects a play group and then a play
within that group. When a play group is selected, a window with the plays available in that group
appears. Thus, each coach can see what play group the other coach has selected before his own play
choice is necessarily finalized. Since the offense is under the pressure of the thirty second clock, this
may give a certain advantage to the defense.

This is realistic, as we described before, because the play groups correspond to formations, and in a
real football game each team (and especially the defense) actually does have a chance to see the other
team's formation before the snap. Nevertheless, some PRO Challenge users may regard the jumping
from play group to play group, guessing, faking, and trigger finger games which can arise from this
knowledge of each other’s play groups as a distraction from the more essential strategy questions of
football. For these users, the program allows the play group windows for each keyboard side to be
independently suppressed. Choosing Play Windows from the Configuration menu causes the game to
freeze and a dialog box to appear in the middle of the screen. The dialog box has two sets of radio
buttons to show whether left or right play selection windows should be displayed or not. When you are
finished, click on the OK button to confirm or the Cancel button to disregard changes.

Without the play group windows, all clues to a play selection are eliminated. If you play the game
with your play selection windows suppressed, you cannot use the mouse for play selection. Instead, you
must use the keyboard and rely on either the playcards or your familiarity with the play groups to know
what you are doing.

The options, Verbose Messages and Play Names, also change the amount of information presented
on the screen during the game, but not in a way that really affects strategy.

Normally, the information displayed in the message area below the field after a play includes details
such as who carried the ball and who performed the tackle, in addition to the number of yards gained
or lost. Such messages are referred to as ‘“Verbose.” You can have the program display “Terse"
messages instead, in which the specific player identities are dropped and only the overall results are
noted. Choosing Verbose Messages turns the Verbose Messages option on or off.

The message area also, by default, displays the names of the plays that were called. You can
exclude this information as well, if you wish. Choosing Play Names turns the Play Names option on or
off.

Note: In Extra-fast mode only terse messages are displayed regardiess of the Verbose message
option at the time Extra-fast mode was engaged.
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11. Undo
Second guessing is an inevitable part of football. In simulated football, unlike the real thing, you can

take second guessing beyond the realm of conjecture. PRO Challenge’s Undo feature allows you to run
a particular play over again, as often as you want, calling a different play every time, or calling the
same play, as you desire.

Game menu: Undo = Undo the previous play, [emd] U.

When you choose Undo, the screen changes to reflect the situation (time, score, yard line, etc.) that
existed immediately prior to the last play that ran. The coaches then are free to select plays and make
any other decisions, whether the same as before or different. The program then runs the play and
announces the new results.

At this point, however, the game returns to the state that existed after the original version of the
previous play, i.e., at the moment the Undo option was selected. The results of alternative plays run
through the Undo function are discarded. You can then choose Undo again, if you want, and run
through the play again; but again the results of the play from the first time through will be restored
before the game moves on. The Undo feature, in other words, cannot be used to actually change the

course of the game.
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